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We are glad to introduce Maxwell plugin for Modo R2 — a plugin interface between Next Limit Maxwell
Render and Luxology modo, allowing users to render their modo models and scenes with Maxwell Render.

Maxwell plugin for Modo R2 is the perfect solution for exporting modo scenes to the Maxwell high-end
render engine. Modo and Maxwell together is what you really need if you want to make exceptional quality
life like images.

Maxwell plugin for Modo R2 can export complex modo scenes to Maxwell Render in a blink. What's more,
you can set the Maxwell specific parameters inside modo and save them with your modo scene.

Key features

Complex scene export from modo to Maxwell
Support for modo mesh deformers (MDD, Morph, Vertex map)
Multiple UV maps

Automatic UV map conversion from modo projected textures (Planar, Cubical, Box, Cylindrical, Spherical
and Front projections)

Export items with Maxwell Motion Blur

modo Instance and Replicator export

Camera export with Maxwell specific parameters

Environment export (automatic/manual)

Maxwell Environment inside modo

Automatic material conversion

Maxwell Material item (assigns “*.mxm" materials to modo items)
Light export (emulates modo lights with emitter objects)

Modo Procedural Texture export (with automatic baking)
Maxwell FIRE - Interactive Preview inside modo

Maxwell Proxy Item
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Workflow

Our aim was to combine the excellent modo workflow with the superb quality of Maxwell Render.

Just start your work in modo as usual. Create the scene models, set UV maps, create modo materials with
textures, adjust lights and environment settings to achieve the preferred scene mood and after that you
can fine tune the scene with the integrated Maxwell items and parameters.

Automatic conversion

The plugin provides automatic conversion for most of the modo settings. It means you don't have to set
Maxwell environment, plugin converts your modo environment to the appropriate Maxwell environment.
You don't have to create Maxwell materials because the plugin converts your modo materials to Maxwell
materials. It is very simple, just click and go. The benefit of this automatic workflow is that your Maxwell
Render will follow your modo scene very closely. This means you can preview your settings with the modo
preview render engine, and enjoy the top quality of the rendered Maxwell image.

Manual settings

Automatic scene conversion is just the beginning. If you want to use the full Maxwell power, you have to
set at least some of the Maxwell parameters and most of the Maxwell materials manually. The modo plugin
attaches Maxwell parameters to the modo scene items, and provides its own Maxwell items for the better
integration. With the attached Maxwell parameters you can fine tune the modo items (camera ISO, shutter
speed, object visibility, etc.), and for more complex tasks you can add our Maxwell items. Currently the
plugin provides two Maxwell items: Maxwell Environment, and Maxwell MXM. These items are tightly
integrated into modo. With Maxwell Environment item you can control the environment settings just like in
Maxwell Studio, and you can also use the advanced Maxwell Physical Sky inside the modo render engine!
Maxwell MXM item provides great control over the referenced MXM materials.
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The installation of Maxwell plugin for Modo R2 is a very easy and straightforward process but there are
some things to consider.

System requirements

Before you begin the installation process make sure that Luxology modo 501 SP3 (or newer version) is
installed on your computer.

It is also recommended to install Next Limit Maxwell 2.6 or newer version before you start the plugin
installation.

Supported Luxology modo versions

modo 501 SP3 (minimum) - Windows 32/64 bit, Mac OSX 32/64 bit.

Supported Maxwell Render version

Maxwell Render 2.6

Installation on Windows

Once you download and decompress the zip file, you have to double click on the Maxwell plugin for Modo
R2 2.6000_setup.exe file. If modo is running, please close it first!

Follow the instructions of the Setup Wizard: select the Destination Location, choose the appropriate plugin
version (32 or 64 bit), and type the name of the Start Menu Folder. That's all you have to do, the installer
will take care of all the other things.

Installation on Mac OSX

Once you download and decompress the dmg file, you have to double click on the Maxwell plugin for
Modo R2 2.6000 package. If modo is running, please close it first! The installer installs the plugin into the
'/Users/<your user name>/Library/Application Support/Luxology/Plugins/Maxwell plugin for Modo R2’
directory. If there is a previous installation, the installer removes it, but it keeps the content of the ‘Default
Export’ folder.
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Background

Modo plugin was originally designed for modo 302. 302 was the first modo version with SDK plugin
interface, a very simple SDK with only file export/import functions. With the development of the first
version of the plugin we have tried to overtake the SDK limitations to be able to release a complete plugin.
Modo 401 has opened some doors but it was still very limited for plugin developers.

With modo 501 Luxology has made the modo SDK more robust, more open for 3" party developers.
Besides the file i/o functions it is possible now to extend the modo capabilities with our own commands,
item types, etc. It doesn’'t mean everything is possible now, but we have much more options to make a
better and more integrated Maxwell plugin.

The new plugin is not just an update; it is a rewritten, redesigned plugin version - Maxwell plugin for Modo
R2.

What has been changed

The main concept is still the same; plugin exports most of the scene items automatically, user has to set the
additional Maxwell parameters/items only if it is needed to reach the final Maxwell quality. (We still
recommend you to use MXM material files for the final image rendering, although the automatic material
export can provide good results in many cases.)

The center of the plugin interface is the Maxwell Render plugin window. We have reorganized the window
layout to make it as compact and clear as possible. In the top half of the window you can reach the main
plugin commands in the lower half you can adjust the Maxwell specific item properties.

Modo 501 Modo 302/401

Preference:

Selection sensitive

Maxwell parameters

NN NS
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Maxwell Properties (Properties +)

Internal handling of the Maxwell item parameters has been changed fundamentally in the new version. In
modo 501 plugins can define their own item packages. It means we can add Maxwell packages to the
modo items - we don't have to add user channels one by one or define additional item tags for the scene
items. It is a more flexible more easily manageable and on the whole a much better solution.

By default plugin adds these Maxwell packages automatically to the scene items, but it is possible to turn
off the automatic mode and add/remove or reset these packages by hand. (Please check the "Add”,

i

“Remove”, "Reset” and “more..." buttons in the plugin window.)

In Maxwell plugin for Modo R2 plugin item parameters are selection sensitive. You don’t have to click on
the "Mesh +", “Camera +", etc. buttons to bring up the property pop-up window, Maxwell parameters
appear in the plugin window as soon as you select an item.

For some Maxwell parameters we have created advanced controls. For example camera Shutter can be
adjusted with the Shutter value and also with the Shutter Angle value as it is in Maxwell Studio.

Polygonal object export

Maxwell plugin recognizes modo items with renderable geometry, and converts them to polygonal objects
automatically. It exports polygonal meshes, subdiv surfaces, static meshes, gear items.... and it works
(theoretically) with any 3" party geometry (we can't be sure without further testing the actual geometry). In
case of complex geometries (for example subdiv surfaces) the export process is about 4-6 times faster
compared to the previous version.

Replicator export

The new replicator export function uses the native modo Replicator Freeze function during the export
process. It means the end result is 100 percent identical to the modo scene replicator, and yes it can export
replicators with Surface Generator source too. Unfortunately it is slower than our previous replicator export
solution (maybe later we will add our previous exporter too - as a selectable export option for replicators).

Maxwell FIRE
Maxwell FIRE works more smoothly and the whole system is more responsive under the new version of the
plugin.

User can tweak camera parameters, environment settings, item positions and scene mxm materials
interactively. In Release 2 it is also possible to follow changes on the Shader Tree settings without
restarting FIRE (in case of Texture Locator or Procedural Texture changes you still have to restart FIRE).

Texture export

Plugin can export Procedural Textures and 3™ party texture layers too. Textures are baked to 2D images
during the export process. (Solid projection mode is not supported.)
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Maxwell Environment

In the previous version of the plugin Maxwell environment parameters were added directly to the modo
Environment Material item. Maxwell environment effect was totally invisible inside modo, although the
plugin provided an option to create environment test image for the modo scene.

In Release 2 we can add Maxwell Environment as a new item to the modo scene. Without Maxwell
Environment item plugin exports the scene with the automatically converted environment. For more
advanced environment control you can add our new Environment item and adjust the Physical Sky, Sky
Dome parameters in a similar way as you can do it in Maxwell Studio.

The new Environment item is visible inside the modo preview viewport because the modo render engine
can handle it. It is a really nice feature because Maxwell Physical Sky can be used with the native modo
render engine too!

You can add Maxwell Environment item from the Shader Tree (Add Layer > Maxwell > Maxwell
Environment), or you can click on the Add Environment button in the plugin window.

Maxwell Environment in modo Preview Render

v Add Layer

Maxwell plugin for Modo R2

PePSERSe®

Maxwell IBL Environment

In modo it is very easy to setup a HDRI scene; you only have to add a HDR
image map on top of the environment material. You don't have to do
anything more to set up an IBL environment! Our plugin converts
environment image layers automatically to IBL environments.

Plugin R2 can handle modo scenes with multiple Environment items. You
can add different HDR images to the different Environments, and control
the IBL layers with the Environment visibility settings.

In the Maxwell Properties viewport you can follow the exported IBL offset

and scale parameters or read about incidental export problems.

NN NN
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Maxwell MXM materials inside modo

MXM material handling has been changed in a similar way as it was shown with the Maxwell Environment

Maxwell MXM material in modo
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In the previous plugin version you had to define mxm materials in the “Replacement mxm" parameter of
the modo material item. The mxm material was not visible in modo, and it was complicated to pair mesh uv
maps or projected uvs with the texture channels of the mxm material file.

Now Maxwell MXM is a new item type in modo. User can add mxm
material items to the Shader Tree as a normal texture layer, and it is also
T possible to drag and drop mxm materials from the modo Preset Browser
or Load MXM material from the Plugin window.

oad MXM materia % Add Environment

When you add an mxm material to the scene, the plugin loads it as a clip
— item to modo, and creates the MXM Material item which handles the
mxm clip and provides further controls for it. The mxm file still has to be
edited in the mxed editor, but the mxm material textures can be
displayed in the modo preview viewport (check the Displayed in modo
control). With the new Maxwell MXM item you can connect Texture

Locators to mxm material Channels directly inside modo.

The connection between the Maxwell MXM item and Maxwell Material
Editor (mxed) is live. You simply resave the material in the Maxwell
Material Editor and the changes are immediately visible inside modo.
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Quick export (Export as...)

In case the installation was successful modo can save your scene to a Maxwell scene file “*.mxs".

Click on the File menu > Export As... menu item and set Save As Type: to Maxwell MXS (*.mxs). Type the
name of the Maxwell scene file and click on the Save button.

Maxwell menu
File Edit View Select Item Geometry Texture VertexMap Animate Render |Maxwel|| Layout System Help

N . . v Maxwell plugin Window...
The plugin integrates its own menu item

into the modo menu bar. Preferences...

The menu provides fast access to important Render

plugin commands (you can read more about Open in Studio
these in the next section) and you can Render Animation...
toggle the state of the Maxwell plugin Maxwell FIRE...
window. MAXWELL Manual...

Plugin Manual...

About plugin

Maxwell plugin window

Maxwell plugin window has two main areas (viewports):

I (e = 1 Render/Export and 2) Maxwell Properties
open export directory open log file
material % Add Environment Render/EXport
Remove Reset In the Render/Export viewport you can find the main options to render

your modo scene with Next Limit Maxwell Render.

B} Preferences open the plugin Preferences window.
See sub-chapter Preferences window.

Info open the plugin About box/Plugin
Manual or Maxwell Render Manual

Start Render export the scene and start render with Maxwell
Render.

a
g Open in Studio export the scene and open it in Maxwell Studio
for further tweaking.

Send Job to Network export the scene and start render with
Maxwell Network module.

NN\ NS
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¥}  Render Animation... open Render Animation window. See sub-chapter Animation window.

= Maxwell FIRE... open FIRE window (Fast Interactive Rendering) See sub-chapter Maxwell FIRE.

open export directory  open the scene export directory. During the scene export process plugin places
the automatically generated “.mxs" materials, environment maps, procedural textures and other things into
this folder.

open log file open the export log file which contains important information about what
happened during the scene export. The information in this file can help you to eliminate scene errors and
incorrect settings.

Load MXM material load an “*mxm" material and add the material item to the top of the Shader Tree.
You can read more about MXM materials in sub-chapter Maxwell MXM item.

Add Environment add Maxwell Environment item to the scene. (It is active only if there is no Maxwell
Environment in the scene yet.) You can read more about Maxwell Environment item in chapter Maxwell MXM
item.

Add/Remove/Reset add, remove or reset Maxwell property packages to (or from) the selected items.
Property packages are collections of Maxwell parameters. You can adjust these Maxwell parameters in the
Maxwell Properties viewport.

Maxwell Properties

In the Maxwell Properties viewport you can set the Maxwell specific item
parameters.

ObjectId (@

You can think about Maxwell parameters as complementary parameters
to the standard modo parameters. You can adjust the normal modo
parameters in the modo Properties viewport and in the same way you
can adjust the Maxwell parameters in the Maxwell Properties viewport.
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Animation window

You can export your modo animation to Maxwell Render as a sequence of “*.mxs" files. It is an automated
process, you only have to set the animation export parameters and click on the Render Animation button
to start the render process.

Render Time (minutes) the maximum number of minutes the
render will spend on a frame.

Sampling Level when the render attains the Sampling
Level specified here, it steps to the next frame.

\.\ Render Animation

Cancel

First Frame beginning frame of the animation
Last Frame ending frame of the animation (it has to come after the First Frame)
Frame Step the gap between the consecutive frames. Normally it is 1, bigger values are useful

for animation test renders.

Tip By clicking on the Copy from modo scene button you can set your Maxwell animation values according
to the modo settings.

Render Animation export scene animation frame by frame and start Maxwell Render in animation
render mode.

Cancel close the Render Animation window.

NN NN
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Preferences window

Maxwell plugin for Modo With the controls in the Preferences window you can

Default Export

customize general plugin behaviors. Preferences are
@ show pop-up vindow categorized into 4 sub-categories. These Categories
are Export, Maxwell FIRE, Workflow and Defaults.

Export

Default Export Directory you can choose the place to where the plugin saves the exported
Maxwell scene files, textures, log file, etc. This parameter defines the default export location but a scene
can have its own location which overwrites this setting (read sub-chapter Render Settings).

The following modes are available:

Default Export: plugin saves the exported files into the {plugin location}\Default Export directory. (This mode keeps
the scene directory clean.)

Scene Directory: plugin saves the exported files into the scene directory.

(Browse...): you can set a custom directory for the exported files.
Show pop-up window show pop-up window if exporter has sent error or warning
messages during the export process.

Automatic Material Conversion

The following settings have effect only on the automatically converted materials!
Collect Images to export directory

Auto convert images some image file formats are supported in modo but not in
Maxwell - for example “*.psd” files. The exporter can convert these image files to a Maxwell compatible
format. You can choose your preferred image file format from the drop-down list, or set it to disabled if
you don't want the automatic conversion. The converted images are saved in the scene export directory.

Clamp Reflectance 0° (color) Maxwell materials with too high Reflectance 0° color value (close
to RGB 255,255,255) can make your image noisy, not realistic. You have this option to automatically clamp
the high color values.

(image) it is the same as the previous control, but it clamps the image
pixel color values.

Skip Displacement component skip modo material Displacement components during the
automatic material conversion.

Skip Emitter component skip modo material Luminosity components during the automatic
material conversion.

NN\ NS
Maxwell plugin for Modo R2 version 2.6000 Page | 14



Maxwell FIRE

Set parameters for the Maxwell Interactive Engine.

Quiality the actual resolution at which the interactive engine renders. Higher value means
better quality but slower preview.

Time (s) the time in sec at which the interactive engine stops rendering

Sampling Level the sampling level at which the interactive engine stops rendering

Use Multiple Threads  allows the Interactive Engine to use multiple cores. If Use All Threads is off, the
interactive engine uses all the available cores minus one. If both Use Multiple Threads and Use All Threads
are off, the interactive engine will use only one core.

Use All Threads use all the available threads for the interactive engine.

Displacement enable/disable displacement calculation in FIRE mode.

Dispersion enable/disable dispersion calculation in FIRE mode.

Motion Blur enable/disable Motion Blur in FIRE mode.

Show Status Info show status information (progress status, elapsed time, sampling level) in the FIRE
window.

Show Log Info show warning message if Log file contains warnings or errors.

Workflow

Auto add Maxwell packages add Maxwell item packages to the scene items automatically. It is
recommended to keep this control on, but - if you want - you can add, remove or reset these parameter
packages manually in the Plugin Window.

Defaults

You can set default values for some of the Maxwell item parameters. The change has no immediate effect,
you have to restart modo to update these settings.

Light Source Offset this parameter controls how far the light source is in reality from the
virtual light model. You can read about it more in chapter Directional Light.

Segments (quality) set the number of the polygons of the light object (cone and sphere side).
You can read about it more in chapter Spot Light.
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Maxwell FIRE

Our plugin integrates Maxwell FIRE (Fast Interactive Rendering) into the modo user interface. With Maxwell
FIRE you can follow the scene changes interactively, without the need to restart the export procedure after
every modification.

It is similar to the modo native Preview Renderer, but the preview is calculated by the Maxwell Render
engine.

Plugin provides a dedicated Maxwell FIRE window for the interactive preview
display. You can activate it by clicking on = (Maxwell FIRE button) in the
Maxwell plugin window.

To start interactive preview, click on the FIRE button.

Another option is to switch any modo viewport to Maxwell FIRE viewport.
First you have to click on the small arrow at the top-right corner of the
viewport, and change viewport type to Card View (from the list select
Application > Card View). After that click on the arrow again and choose
Viewport Settings > Maxwell Render - FIRE.

Maxwell FIRE greatly improves scene setup and the overall workflow. If you change item transformation
values, material components (mxm and converted materials too), light parameters, environment settings,
etc. the FIRE viewport refreshes immediately with the new scene parameters.

In some cases automatic refresh is not possible. In these cases you have to reload the FIRE engine to follow
the changes.

You have to reload the engine after these events:

e new geometries, geometry changes,
e uv map changes, texture locator projection changes,
e material mask changes

FIRE interactive viewport has three control buttons: Options, Pause/Start and Reload.

Options opens the Maxwell FIRE preferences pop-up
window where you can control the main parameters of the
Interactive Engine. You can read more about these preferences
in sub-chapter Maxwell FIRE.

Pause/Start Pause or Start the interactive preview engine.
Reload re-exports the current scene, including all the
changes.

NN NN
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Integration with modo Preset Browser

You can use modo Preset Browser to add MXM materials or Maxwell Sky preset files to your scene models,

environments.

The plugin installer adds the Maxwell Material Database /mxm files and /skies directories to the modo

Preset folders!

Click on the drop down list (middle-top of the Preset window), and select mxm files or skies.

- t + o

(parent)

carpaint_gre.,..

»

default.mxm

frosted_glas...

soap_bubble...

|

abs_plastic_...

carpaint_che...

defaultg7.mxm

leather.mxm

The Presets Browser is very useful if you
want to apply your predefined Maxwell
files to modo scene elements.

Just drag and drop the

thumbnails from the Preset Browser

preset

onto the modo geometry, Shader Tree,
or in case of Sky presets to the render
or viewport background. It is very fast
and intuitive.

Note You can apply Sky preset by
double clicking on the sky thumbnail.

<< On the MXM file thumbnails you
can see the material preview image.

Sky thumbnails show Maxwell skies
with different intensity settings. > >

Maxwell plugin for Modo R2 version 2.6000

luedear_darkerhorizon ...

dearsky_tom.sky default.sky

san franasco fog.sky

Note Sky thumbnails are
generated at fixed f-Stop and
Shutter Speed values (f-Stop 4,
1/s 1000). The ISO value varies
from image to image to have
an exposure value where the
widest spectrum of the sky
colors are visible.
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Customize plugin Ul

Modo user interface is well known of its great customizability. You can change any modo viewport to
plugin viewport with 4 easy steps.

e Click on the little arrow (top right corner of the viewport).

e From the list choose Form View.

e Click again on the arrow and from the list choose Viewport Settings. After you click on Viewport
Settings, modo opens a new list. In the list you can find the plugin viewports (Maxwell Render —
Main UL, Maxwell Render — Maxwell Properties,...).

e Click on the name of the plugin viewport.

If you want to change a modo viewport to Maxwell FIRE viewport, at the second step choose Card View
instead of Form View, and from Viewport Settings choose Maxwell Render - FIRE.

yort Group

3D Edit

Application

rt Controls

MDD Defor
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In this chapter you can read about how the different modo item types are exported by the plugin and
about the available Maxwell item parameters you can play with.

In modo all the scene settings, parameters are connected to scene items. For example you can change
render setting by adjusting the properties of the render item. Plugin follows the same logic, Maxwell render
settings are connected to the Render item.

To adjust Maxwell Render settings first you have to click on the Render item. In case the render item is
selected, you can see the Maxwell render parameters in the Maxwell Properties viewport.

Because of the big number of Render parameters we have grouped these into three Form Tabs: Render
settings, Render Output and Channels/Layers.

Render Settings

Mascwell Properties Export Directory export directory is the place where the exporter
Exporter o

e 2l saves the exported mxs scene, images, etc. files. You can set the default

only in FIRE mode 2l export directory in the Preferences window, but here you can set export

m Export Lights

directory for the actual scene. If Export Directory is in (from Preference)

Protect Geometry

mode, it means the scene doesn't have its own export directory, it uses the
global default. If you select (Browse...) from the drop-down list, you can set
custom export directory for the scene.

Production

— d Export Hidden in case you want to export your hidden scene items

Disabled

o e you have to check this control. It is only useful if you want to tweak your
ok scene in Maxwell Studio. If you export your scene directly to Maxwell Render

Motion Blur

it is better to keep it unchecked, so the exported “*.mxs” file and the render
data won't contain the unneeded item data (the export process will be

faster).

Export Lights check this control if you want to export/convert your modo lights to Maxwell
Render. Although Maxwell doesn’'t have modo compatible light system, Maxwell plugin for Modo R2 can
covert modo lights for Maxwell Render (see chapter Lights).

Protect Geometry if you export the scene in protected geometry mode, Maxwell Studio won't allow
further export from the exported scene file.

Render Time set the maximum render time (in minutes) for the render. The longer the time, the
cleaner and more accurate your image will be.

Sampling Level maximum sampling level required. The render will stop when this SL is reached.

CPU Threads number of threads dedicated to the render. By default, 0 means that all available
CPUs/ Cores will be used.

Global Scale you can scale up or down the Maxwell scene during the export process. Value 1.0
means the exported items will have the same size what they have in modo.

NN\ NS
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Quiality two different qualities are available: Draft and Production quality.

Priority you can set the rendering process to normal or low priority. This is useful if you
wish to work on your computer while rendering.

Mutilight Disabled / Intensity / Color and Intensity are the different Multilight modes. You
can even choose between exporting all the emitters contribution to independent images (Separate), or
saving only the composed render (Composite).

Command Line pass command line parameters to Maxwell Render. About the available command
line parameters please read the Maxwell Manual (Appendix III).

Motion Blur control scene motion blur. You have three options: Disabled — no motion blur,
Camera only — motion blur only from camera movements, Enabled — item and camera motion blur.

MB Steps the number of transformation steps the plugin exports for geometry items.
MB Offset you can set when the shutter opens compared to the current frame.

MB Offset=1: Shutter opens before the current frame and closes at the current frame. MB Offset=0.5:
Shutter opens before the current frame and closes after the current frame (this is how modo MB works).
MB Offset=0: Shutter opens at the current frame and closes after the current frame.

Displacement enable/disable displacement rendering.
Dispersion enable/disable dispersion rendering.
Render Output

The Render Output properties are also part of the normal Maxwell workflow.

MXI

SBUmaS JBpUsY

Broy
RGB 16 bpp

Devignetting Value

The Render Channel and Render Layer properties are also part of the normal
Maxwell workflow.

¥ sbumas sspuay
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Environment export is a good example for how well automatic export can work together with the manual
export settings. By default plugin converts modo environment settings automatically. You set the scene
environment in modo and the plugin follows your settings and chooses the right Maxwell environment
type with the proper parameters.

The conversion happens according to the following rules:
- Modo environment with Constant color or 2 - 4 Color Gradient and Overcast Sky -> plugin creates the
environment gradient image according to the modo settings, and set the exported image as IBL environment.
- Modo with Physically-based Daylight -> exported as Maxwell Physical Sky
- Modo with HDR or EXR image environment -> the result is Maxwell IBL environment with the appropriate hdr
or exr image file.
Automatic conversion doesn't forget about the virtual sun of the scene. If your scene has Directional Light
item with Physical Sun turned on, it will be exported as Maxwell sun.

If automatic environment conversion is not enough for you (for example you want better control over the
Physical Sky settings), you can add our Maxwell Environment item as a top layer on your modo
environment. With Maxwell Environment item you have similar Environment options what you have in
Maxwell Studio.

modo Environment item

We added extra controls to the modo Environment item to make
environment conversion easier.

On the top of the Environment tab you can see the INFO line. This INFO
line gives quick information about the exported environment type. Type

% Background

2 tlumination can be None, Physical SKy, Dome SKy, IBL (image map) and IBL (gradient

ﬁ Reflectio

% Refraction
Gradentenv. BT NEEEED Environment item. For example Environment Material with 2 Color

env.). Exported environment type is the result of the layer items under the

Gradient type will be recognized as IBL (gradient env.). If you change 2

Color Gradient to Physically-based Daylight, or you add a Maxwell
Material item with Physical SKy type, the final environment will be Physical Sky. If you add a HDR image to
the top of the Environment layers, it will change the exported environment type to IBL (image map).

In case of IBL environment types, you have further controls:

Intensity intensity value for the IBL layers (this control changes the intensity of the modo
Environment too).

Background, Illumination, Reflection, Refraction enable/disable the effect of the IBL environment on the
various IBL layers. (These controls are not independent from the modo environment visibility switches:

Background changes Visible to Camera, Illumination changes Visible to Indirect Rays, Reflection changes
Visible to Reflection Rays and Refraction changes Visible to Refraction Rays.)
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Gradient env.  size (in pixels) of the exported gradient image. Use bigger number if you want better
image quality, but bigger file means longer preprocessing time in Maxwell Render. Plugin exports modo
Environment Material with Environment type Constant, 2 Color Gradient, 4 Color Gradient or CIE Overcast Sky
as an EXR image file. When the file is ready, it sets the new image file for the IBL background layers.

Maxwell Environment item

Maxwell Environment is a Shader Tree texture layer item. You can add Maxwell Environment layer from the
Plugin window (Add Environment button), you can use modo Preset Browser (by double clicking on the sky
preset thumbnail), or you can add it as a normal modo texture
layer by clicking on the Add Layer drop-down button at the top
of the Shader Tree (from the drop-down list select Maxwell >

Maxwell Environment).

Enable enable/disable Maxwell Environment layer.

Render in modo set it to ON if you want modo to display
Maxwell Environment in modo preview and final render.

Type type of the Maxwell environment: None, Sky
Dome, Physical Sky. In Maxwell Studio you can choose IBL
environment too, but in modo IBL environment is automatically
converted from modo environment settings (read next sub-chapter
IBL).

Sun display switch direct sunlight on/off. (Sky Dome or
Physical Sky environments)

Please read sub-chapter Sky Dome and Physical Sky in the
MAXWELL RENDER 2 Manual for further information about Maxwell
environment settings.

Render: Done | L 1A Note You can follow the effect of the Maxwell Environment settings in
el the modo preview window and you can use Maxwell Physical Sky or Sky
Dome with modo render. (If you want to use Maxwell Physical Sky or Sky
Dome in a modo render, please make sure Render in Modo checkbox is
ON.)

IBL

If you want to light your Maxwell scene with High Dynamic Range image(s) you have to set-up the HDR
environment as you normally do it in modo. You can use any HDR or EXR image to light your modo scene
and with the connected Texture Locator you can position the HDR background.

In most cases the conversion works without your further assistance, but there are some limitations you
have to keep in mind.
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IBL conversion works only with front or spherical projected environment images.

- In case of Front projection the only limitation is that the Projection Camera has to be the same as
the render camera.

- In case of Spherical projection it is important to keep the Texture Locator main axis parallel with
the modo Up Axis, otherwise the plugin can't find appropriate settings for the conversion. (It is OK
to rotate the image around the Up Axis, and it is also valid to flip it upside down.) Further
limitations: a) Environment image has to be in 0,0,0 position. b) Environment Image has to be
uniformly scaled.

Texture Locator with Front projection Texture Locator with Spherical Projection

—— HDRI environment - Maxwell IBL  HDRI environment - Maxwell IBL

modo Maxwell modo Maxwell

Tip You can use modo Horizontal and Vertical Wrap controls to alter the look of your environment image!

Modo plugin provides live feedback about the HDR image -> IBL conversion in
the Maxwell Properties viewport. You can read the exported IBL offset and scale
values (these are calculated from the Texture Locator of the HDR image), and if
the plugin can't convert the Locator parameters perfectly, it displays warning
messages with the conversion problem in the INFO field.

IBL layers

If you want to use different images for the different Maxwell IBL layers (Background, Reflection, Refraction,
Illumination), you can follow the normal modo workflow again.

Create two or more modo Environment item (on the picture you can see
Environment (2) and Environment), and with the visibility flags set the
scope of the Environment items.

If Visible to Camera is on, the HDR image in the Environment item will
be exported as IBL Background layer.

If Visible to Indirect Rays is on, the HDR image in the Environment item
will be exported as IBL Illumination layer.

If Visible to Reflection Rays is on, the HDR image in the Environment
item will be exported as IBL Reflection layer.

If Visible to Refraction Rays is on, the HDR image in the Environment
item will be exported as IBL Refraction layer.

NN NN
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Plugin attaches object properties to items with renderable geometry. These are Mesh items, Static Meshes
but other item types too (for example Gear item or other 3" party plugin items with geometry data).
Maxwell Properties Disable MB disable motion blur for this item.
A 5 s a Object Id you can set color for the Mesh item. Maxwell Render
POeSel0 0.6 0.93 0.01 | will render this item with this color in Object ID render mode, so it is
1% visibiity by Shader Tree easier to manipulate the object in a 2D paint program.

Visibility by Shader Tree sets the visibility options (hidden from camera, reflection, refraction or GI) of the
object according to its modo Shader settings.

Hidden from Camera  hide the object from the render view but allow it to contribute to the render
calculation (cast shadows, refract, etc.).

Hidden from Refl/Refr reflected or refracted objects are hidden.
Hidden from GI the object will render but it will not affect lighting.

Hidden from Z-clip the object will not be cut by Z-clip planes.
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Maxwell and modo Camera objects have many common

vell Properties

parameters (these are automatically exported by the plugin) but
Maxwell has some special parameters.

Please read chapter Cameras in
the MAXWELL RENDER 2 Manual for

more  information  about  Maxwell
Cameras.
i:\l,itljf;:l‘ZUS .
: Exposure with  the Exposure
Aperture (| Circular control you can lock the exposure to a

certain value or you can switch to
useful preset settings.
TIP With locked exposure you can

easily control the amount of DOF by
changing the F-Stop value. Exposure List

ISO the film's light-sensitivity, higher ISO means more sensitive film.

Shutter (1/n)  the shutter speed or the time light has to reach the film is specified in 1/n of a second. A
higher number means the light has less time to reach the film.

Shutter Angle this option allows you to control the amount of motion blur in an image in animations.

F-Stop controls the aperture of the lens. You can change F-Stop at the modo camera properties
too.

Focal Distance distance from the camera location to the camera target. The camera target represents the
point where your render will be in perfect focus. You can change Focal Distance at the modo camera
properties too (it is called Focus Distance there).

TIP If you click on the Autofocus button modo automatically chooses the right focus distance for your
camera.

Aperture controls the shape of the 'bokeh' effect seen in out-of-focus highlights

Blades the number of blades of 'Polygonal' cameras

Angle the angle of blades in 'Polygonal’ cameras

Z-clip enables/disables Camera Z-Clip planes

Z-near the near-plane Z-Clipping distance (must be less than Far Clipping Plane)

Z-far the far-plane Z-Clipping distance (must be greater than Near Clipping Plane).
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Our plugin has complex mechanisms to convert modo materials to Maxwell materials automatically. You
can set your modo material, adjust its values (transparency, reflectivity, etc.), add your texture images and
the plugin creates the Maxwell material for you. It is so easy!

Automatic conversion is good enough in some situations, but for a really high quality render you have to
use real Maxwell materials. Maxwell plugin for Modo R2 can handle “*.mxm" material files, so you can use
your own Maxwell materials inside modo or you can download material files from the more than 3000 free
Maxwell materials you can find on the WEB.

Maxwell MXM item

To handle Maxwell mxm materials inside modo you have to add Maxwell MXM item(s) to your scene.
Maxwell MXM is somewhat similar to the Image Map item, but while Image Map connects image clips to
the scene materials, Maxwell MXM does the same with mxm files.

Actually the plugin loads the mxm material files into the scene as clip items, and Maxwell MXM represents
the mxm file in the Shader Tree and attaches uv maps or texture projection (via Texture Locators) to the
textures inside the material file.

e You can add Maxwell MXM items to the scene from the plugin
1% Enable =]l window (Load MXM Material button), from the Shader Tree (Add
%4 Render in modo

Layer > Maxwell > Maxwell MXM) or you
can drag and drop it from the Preset

Y Edit MXM

Browser onto a geometry item.
oilpaint_bvirion.mxm ...

(auto select) Reflec...

Enable enable/disable Maxwell MXM layer.
* oilpaint_bvirion (MX... ™

Render in modo set it to ON if you want modo to display
Maxwell MXM in preview and final render.

View quick display of the mxm material preview
thumbnail.

Edit MXM opens the mxm file in the Maxwell Material
Editor.

MXM file the mxm file connected to the Maxwell

MXM item. With this control you can load other mxm files from your computer (load mxm), download it
from Maxwell web catalog (load from Web Gallery) or you can create a new mxm file (new mxm).

Displayed in modo you can select the

- Channel 0

material texture you want to display in . .
modo. In the drop-down list you can see the Pt roe ok e eI o P - Geredy

- Channel 0

layers and components of the material _
(bsdf, emitter, displacement, coating) and s ; g

the available textures with the associated
channel numbers. The first item in the list is an automatic proposal from the program (plugin tries to find
the most typical texture or color for material display).

NN NN
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Channel Locators

In the Channel Locators area you can see the channel ids of the mxm file and the associated Texture
Locators. With these controls it is very easy to connect Mesh uvs or projected uvs (via Texture Locators) to
the Maxwell materials.

You can follow the uv projection changes in the modo preview render window or in any 3D Model viewport
with RayGL.

The connection between Maxwell MXM and Maxwell
Material Editor is live. It is especially useful if Maxwell
FIRE is running and you want to fine tune the material,
or if you want to change the uv projection parameters.
(In the second case you can follow the changes not just
in Maxwell FIRE but in the modo preview window too).
After you save the changes in mxed, the material
updates automatically inside modo.

TIP It is recommended to use Maxwell Material Editor
in Always on top mode. You can switch to Always on top
mode in the mxed File menu. In this mode the material
editor is always visible - it feels as an integrated part to the
modo UL
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Modo plugin can export modo procedural textures (cellular, checker, wood, and other 3™ party textures)
with its texture baking option. If the plugin recognizes an item as a possible procedural texture item, it
adds the Texture Baking parameters to the item. With these parameters you can set the appropriate export

option for the texture (image size, format).

Texture baking is a relatively slow process. To accelerate the process the plugin stores information about
the already exported texture images in a [LIST]_bakedTextures.list file (every exported scene has its own
list file). The list file works like a cache, plugin bakes the texture file only if it is needed.

Note Automatic texture baking works only with the automatically converted materials!

Export Texture enable automatic texture baking for the Texture

item
Size size of the exported texture image.
Format format of the exported texture image.

Note Plugin can't handle Solid projection mode. (It uses Cubic projection instead of Solid projection during
the export process)!
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Maxwell Render doesn't have virtual light system as you have in modo, so the plugin has to convert modo
lights to Maxwell emitter objects.

Directional Light

The conversion method of the Directional Light items depends on whether you checked the Physical Sun
check box or not. In case you use the Directional Light object as a modo sun, plugin uses the location, time
information of the modo sun to convert it to sun information for Maxwell environments. In this case the
light geometry is not exported.

If it is a simple Directional Light item without sun parameters, plugin converts it as a distant emitter object
(small circular geometry) with high emission power values.

For Directional light export the plugin uses a special parameter: Light Source Offset. (You can change the
value of this parameter in the Maxwell Properties viewport.) Light Source Offset controls how far the light
source is in reality from the virtual light model. If you want to have sun like light source, the light object
should be really far from your scene center. The default (and recommended) distance is 150 km. From this
distance the light rays are almost parallels, and this is how sun light should behave. An emitter object
needs very high emission power value to light the scene from this distance, but if you set the distance
shorter, lower energy level is still enough. (The exporter automatically adjusts the emission power
according to the Light Source Offset value.) Normally the possible biggest distance is what you need, but in
case you have other scene lights with much lower emission power values, the high setting of the
Directional Light emitter can make it difficult for the render engine to adequately render the weaker
emitters. In these cases you have to balance with the Light Source Offset value to keep the right sun light
effect, but with the lowest emission power. In the following pictures you can see how this parameter
changes the effect of the light. The first picture (from left) shows the original modo render. The second
picture shows how well the plugin emulates modo Directional Light if the offset value is big enough - the
cost of it is the enormous emission power value. On the third picture the offset value is smaller which
means lower emission power, but the conversion is still OK. The fourth picture is an example for what
happens if the distance is too low. The light effect feels very local (rays are not parallel).

Original modo render Maxwell: Light Source Offset: 150 Km Light Source Offset: 100 m Light Source Offset: 10 m
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Plugin can simulate the Spread Angle value of the modo Directional Light items. On the following pictures
you can see some samples.

‘Q |$ N %

Spread angle 0°: modo Spread angle 0°: Maxwell Spread angle 30°: modo Spread angle 30°: Maxwell

Spot Light

Plugin exports Spot Light items as a combination of an emitter sphere object and a cone geometry with
reflective material. It is a very simple lamp model, but it simulates modo Spot Light items very well.

The exporter takes care of the Cone Angle and Soft Edge parameters of the Spot Light Item.

Cone Angle 30°,Soft Edge 0° Cone Angle 30°,Soft Edge 10°
modo Maxwell modo Maxwell
Cone Angle 50°,Soft Edge 0° Segment 8 Segment 64

modo Maxwell There is a special Spot Light parameter:
Segments. This parameters sets the number
ofthe polygon sides of the lamp geometry.
If Segments value is too low, the side of the
light circle will be squarish.

Tip It is better to keep this value low,
otherwise it will cost in render time.
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Other light types

Photometric Light export is very straightforward. Maxwell Render V2 can use IES and Eulumdat files, so the
plugin simply passes the IES or Eulumdat file to the emitter material file. The exporter creates a small
sphere object and assigns the previously created emitter material to it.

Point Lights are exported as small sphere geometries with emitter material.
Dome Lights are exported as huge sphere geometries with emitter material.
Cylinder Lights are exported as cylindrical geometries with emitter material.

Area Lights are exported as rectangular or elliptical geometries (it depends on the Area Light Shape
control) with emitter material.

Tip you can overwrite the automatically converted Light Material with an “*mxm” file the same way as you
can overwrite item materials (see sub-chapter Maxwell MXM item).

Light Properties

Radiance multiplier radiance intensity multiplier for the exported

Radiance multipli

Maxwell light. The exporter tries to export the lamp emission material
with the right radiance value, but you can further tweak it with this
parameter.

Light Source Offset (for Directional Light items) this parameter
controls how far the light source is in reality from the virtual light model.
If you want to simulate the effect of a virtual sun object, the light should
be really far from your scene center. The default (and recommended)
distance is 150 km.

Segments (for Spot Light items) set the polygon number of the virtual light object. More polygons =
better quality, but it can dramatically increase the render time!
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Instance

Modo Instance Mesh items are converted into Maxwell instance objects.

Replicator

Meowel Propertics B During the export process plugin converts the elements of the
Ekport Mode: (SI5pyense @l replicator item to Maxwell instances.

Export Mode  you can choose from two export mode.

In precise mode the plugin converts the replicator with the help of

the modo Replicator freeze option. The created instance objects
follow the randomization, rotation, scale defined in the modo replicator item, and you can use all kind of
replicator point sources available in modo (Mesh item, Surface Generator, 3™ party particle items, etc.).
Modo Replicator freeze option can be very slow! If you are working with huge number of particles it can be
better to choose fast export mode.

In fast mode plugin uses its own function to convert the replicator item to Maxwell instances. It is much
faster than precise mode, but the randomization of the resulted items doesn’t match exactly the original
modo Replicator. (This mode can handle Mesh or Surface Generator point sources but not the 3™ party
particle items.)

b l\\"ﬁ\j\‘* “\\’f ”'
Rl

ELIRIES

modo Maxwell Maxwell — fast mode
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With Maxwell Proxy item you can integrate Maxwell Proxy objects into the modo scene. It means you can
merge whole Maxwell scenes into your modo scene without slowing down your viewport.

Masxwell Properties MXS Reference the attached mxs file.

eference  (floadmis) : Scene Bounding Box  show/hide the Bounding Box of the
referenced scene.

% Scene Bounding Box

% 1tem Bounding Boxes Item Bounding Boxes show/hide the object Bounding Boxes
Vet of the referenced mxs scene.

Vertices show/hide the object vertices of the

referenced mxs scene.
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This list is not full!

Coordinate System
e Y-up system supported
e Z-up system supported
Item
e Position, Rotation, Scale
e Visibility
Mesh
e Polygons, Texts, Spline Patches, Subdivs
e Vertex/Polygon Normals
e multiple UV maps

Mesh Instance
Camera

e Focal Length

e Film Width

¢ Film Height

e Film Offset X

e Film Offset Y

e Film Fit

e Focus Distance
e F-Stop

Light
¢ Point Light
o Radiant Intensity
o Directional Light
o Radiant Existance
o Physical Sun
o Spread Angle

e Spot Light
o Cone Angle
o Radiant Intensity
o Soft Edge

e Photometric Light
o IES files
e Supported Layer parameters
e Enable
e Opacity
e Invert
¢ Supported Material Items
¢ Light Material
e Constant
Texture Locator

e Projection modes (Planar, Cubical, Box, Cylindrical, Spherical, Front, Solid, UV Map) —

Replicator

¢ Prototype (can be group — with variability, mesh item, or replicator)
¢ Point Source

e Source Mode (Point Data, Align to Surface)

¢ Include Child Items

NSNS
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e Render Density
e Seed
e Random Offset, Random Twist , Random Scale with or without uniform scale

Environment
Intensity
e Visible To Camera, Visible To Indirect Rays, Visible To Reflection Rays, Visible To Refraction Rays

e Supported Layer parameters
e Enable
e Opacity
e Invert
e Supported Material Items
e Environment Material
Environment Type

o Sun Light

e Constant
Image Map
Projection Type

Horizontal Wrap
o Vertical Wrap

Render
e Render Camera
e Frame Width
e Frame Height
¢ Pixel Aspect Ratio
e Render Region
¢ Supported Layer parameters
e Enable
¢ Opacity
e Invert
¢ Supported Layer effects
¢ Diffuse Color
e Bump
e Luminous Color
e Luminous Amount
¢ Supported Material Items
Default Shader
o Visible To Camera
o Visible To Indirect Rays
o Visible To Reflection Rays

o Visible To Refraction Rays

e Group Mask

o Item filter

o Polygon Tag filter (Material, Part and Group )
e Advanced Material

o Diffuse Color

o Diffuse Amount

NSNS
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Specular Color
Specular Amount
Roughness
Anisotropy
Reflection Color
Reflection Amount
Transparent Color
Transparent Amount
Bump Strength
Displacement
Luminous Intensity
Luminous Color
¢ Constant Material

o Color
¢ Image Map

o Projection Type (Planar, Cubical, Box, Cylindrical, Spherical, Front, UV Map)

o Horizontal Wrap

o Vertical Wrap

o Horizontal Repeat

O O O 0O 0O 0O O O O O O o

o Vertical Repeat

o Texture Filtering

NSNS
Maxwell plugin for Modo R2 version 2.6000 Page | 36



e Old scenes (started in earlier version of modo - before 302) can make modo crash during the export!
It also can happen that the export process runs fine, but the exported parameters are not correct.
For example instanced items are not exported well, sun position is wrong, etc. - Please start a new
scene in modo and copy your old items into the newly created scene. This can solve the problem.

e Light Probe and Implicit UV projection modes are not supported.

e Plugin can't export procedural textures with Solid projection type

e Plugin can't blend Image Maps together, only the top image is exported.

e Modo fur is not supported.

e Plugin can't export channels with linked sources. If you want the plug-in to use the real values of the
linked channels, please bake out those channels.
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e [Is there an option to reset the layout of the plugin window? I have accidentally changed it,
and I don't know how to change it back] Plugin has no option to reset its Ul but you can easily do
it manually. Please read sub-chapter Customize plugin Ul.
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Luxology and modo are registered trademarks of Luxology, LLC.

Maxwell Render is a registered trademark of Next Limit SL.
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